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Maintaining Balance
Topic(s): 
Grade level(s): 5th – 8th grades
Time: 45-80 minutes
Maine Science and Engineering Standards: 5-LS2-1, MS-LS2-4, HS-LS2-7


ACTIVITY OVERVIEW
In this design challenge, students will discuss ecosystems and take part in a species survival demonstration. This demonstration will challenge students to remove as many species from the environment as possible within one minute and discuss their results.  The students will then be presented with the following problem: “Our ecosystem’s population balance has gone out of control. We need to fix our ecosystem to make sure there is equilibrium amongst the species.”  The students will put on their engineering hats to assist in maintaining species populations within an ecosystem. The teams will have an opportunity to design a tool to remove the invasive species and restore balance to the ecosystem.



ALIGNMENT TO STANDARDS
[bookmark: _heading=h.1fob9te]Maine Science and Engineering Standards
5-LS2-1 Develop a model to describe the movement of matter among plants, animals, decomposers, and the environment.
MS-LS2-4 Construct an argument supported by empirical evidence that changes to physical or biological components of an ecosystem affect populations.
HS-LS2-7 Design, evaluate and refine a solution for reducing the impacts of human activities on the environment and biodiversity.

LEARNING OUTCOMES
The students will be able to: 
· Describe the physical characteristics of an environment and how these characteristics support a population
· Describe environmental changes that cause some organisms to thrive, and others to perish
· Describe the flow of energy through food webs and predict how changes to the ecosystem affect the food web
· Solve a problem using the engineering design process
· Identify patterns in real-world problems and make predictions based on the pattern.

Students will use the following STEM fluency skills: 
· Communication
· Collaboration
· Creativity
· Critical Thinking
· Resilience
· Time/Resource Management
· Innovation
· Adaptability





 

           		       

   

Materials needed for this design challenge:
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· Artificial turf	No cost
· Turf container	No cost
· Tweezers	$4,00 per pair
· Straws	$1,00 per straw
· Scissors	$1,00 per pair
· Tape	$1,00 per roll
· Hand rake	$4,00 per rake
· Hand shovel	$3,00 per shovel
· Sieve	$3,00 per sieve
· Comb	$3,00 per comb
· Plastic spoon	$1,50 per spoon
· Plastic fork	$1,50 per fork
· Chenille sticks	$1,00 per stick
· Fan	$2,00 per fan
· UV Flashlight	$2,00 per flashlight
· String	$1,00 per 10 cm
· Water	$2,00 per 1000 mL

Materials needed by the facilitator:
· Computer with Image J
· Dark box with UV light and camera
· Projector
· Slide deck for the lesson
· Copies of the scorecard per group
· Timing device
ImageJ Use Guidelines
ImageJ is used to measure the amount of invasive species present via fluorescence.  To get a fluorescence reading:
1. Place tin with turf and beads inside a dark box.
2. Take a picture with a UV light on.
3. Open this image with ImageJ.
4. Turn the image into black and white
a. Select Image > Type > 8 bit
5. Set the white threshold
a. Select Image > Auto Threshold > Method (huang 2), Select “white object on black background”
6. Select the full image area with a rectangle
7. Get the percentage of white areas
a. Select Analyze > Analyze Particles > Display Results > Select Summarize
8. View % Area to get a value for the amount of fluorescence
PRE-LABORATORY ENGAGEMENT
Before the mobile lab visit, it is recommended that students conduct the PBS Platte River Prairies Interactive Food Chains/ Food Webs activity.  The PBS resources include student handouts and teacher guides.  We recommend conducting the third activity, which utilizes a web-based interactive.
Priming Questions Before the Lab Activity:
1. What happens when you remove a species from the food chain/food web?
2. What are invasive species?
3. How do invasive species affect the food chain/food web?
POST-LABORATORY ENGAGEMENT
After the mobile lab visit, teachers can utilize the activity, Come Sail Away.  In this activity students can learn about how invasive weed species have evolved to have efficient and effective seed dispersal.  Students will engineer new seed designs and can practice graphing time aloft versus distance traveled to see if there are correlations.



LESSON PLAN

	[bookmark: _heading=h.3znysh7]SECTION
	PROCEDURE

	INTRODUCTION
	Slide 1: Maintaining a Balance
· Introduce today’s lesson on ecosystems.
Slide 2: Ecosystem
· Discuss food webs and the role of species within the food web. 
· Ask students how species have adapted to survive in this food web/ecosystem.
· Why are hawks the apex predator?
· Flying makes it so others can’t target them and gives them an advantage over prey
· Excellent vision
· Sharp claws
· Speed
· How do snakes, rabbits, and lizards survive from the hawk?
· Hiding in the grass
· Burrowing underneath the ground
· Using Camouflage
· How do mice and grasshoppers survive from snakes and lizards?
· Hiding in small holes that snakes cannot fit inside
· Quicker than their predator 
· What will happen if we remove the grass?
· Everything will eventually disappear because the herbivores would not have food and the food web would be disrupted.  
· Animals and insects would either die or move somewhere else.
· Ask students what happens when a species disappears from an ecosystem.
· Other species could go endangered or extinct
· The environment could be destroyed by overgrazing or overpopulation
· Negative impact on breeding grounds
· Food sources might become scarce
· Invasive species outcompete apex predators and have no natural predator
· Ask students: How can we protect ecosystems? 
· Protect the existing environment as sanctuaries or national parks
· Avoid or limit practices that destroy the environment like deforestation
· Remove an invasive species by utilizing traps or other removal procedures
Slide 3-4: Part 1 Predator vs. Prey
· This species survival demonstration or activity will challenge students to remove as many species from the environment as possible within one minute and discuss their results.
· Students will establish on their team who will be picking the invasive species out of the ecosystem.
· Using only one hand, the picker will collect as many of the species as possible within 30 seconds. They can only pick one species up at a time.
· Once the 30 seconds is up, they will separate the species into the mini cups according to the color and size, and then count how many were picked out of the ecosystem.
· Ask students which species they picked the most and which were the least picked.
· Ask students why they think that happened.
· The larger beads were easier to see because they were bigger and brighter 
· Ask students how they think their experience connects to an ecosystem’s food web with predators and prey.
· Predators will target the easier-to-catch prey leaving population imbalances. These imbalances put the health of an ecosystem at risk. If all the mice are gone, what happens to the snake?  How does that impact the hawk? 
· As the snake’s food source decreases, it might starve or leave the ecosystem.
· If the snakes are gone then fewer hawks would survive
· Rabbit and lizard populations would increase, and their food sources would become scarce.
Slide 5: Engineering Design 
· Ask students the question. What is engineering? 
· Explain to students that engineering is when engineers take what they know and apply it to solve problems by designing a product or process. 
· For example, phones could only be used at home or in specific locations. Why is this a problem? (Needing to make a call outside the home). What solution did engineers design to fix that problem? (Cell phones). 
Slide 6: Engineering Design
· Ask students the question. What are some examples of engineering jobs?
· Teacher’s Note: If students have trouble giving examples, ask students who they think makes the things they use. Who makes refrigerators, cars, helmets, cell phones, and sneakers? 
Slides 7-9: Engineering Jobs
· Show students pictures related to engineering jobs connected to the challenge.
· Environmental Engineering
· Ask students what they see in the pictures.
· Explain to students that engineers who study the planet and natural materials are called environmental engineers. They use science to help the Earth. Some of the work they do can help make plants grow bigger and healthier or understand why there are population imbalances in the ecosystem.
· Ask students why they think population imbalances would happen in the ecosystem. Explain that the change in the climate results in different producers being grown, which impacts which consumers survive. Another explanation is when invasive species grow out of control and limit the growth of the native species. The devastation to the environment via natural causes or human construction could also force species to leave the area and then affect the food web.
· Civil Engineering
· Ask students what they see in the pictures. Ask them: How does it look different from architecture?
· Explaining to students what they are seeing in the pictures is called civil engineering. While architecture combines art and science to build buildings, civil engineers use math and a type of science called physics to build buildings that help people. Architects and civil engineers are also different because while architects mainly focus on buildings, civil engineers will build many structures like bridges, highways, towers, and water systems!
· Ask students if they think climbing a beanstalk is safe. What could make it safer? Explain to students that a civil engineer would be the one to help makes that beanstalk safer.
· Chemical Engineering
· Ask students what they see in the pictures.
· Explain to students that this is called chemical engineering. This is when engineers specialize in working with things called chemicals. Chemicals are things that cannot be broken down without changing what it is. An example of a chemical is water, oxygen, or gold!
· Ask students why would learning about chemicals be important for an ecosystem. Explain to students that chemical spills occur, and we need to understand the impacts of the damage it leaves.  We also can try to control invasive species through the use of chemicals.
Slide 10: Engineering Design
· Ask students the question: who can be an engineer?
· Anyone!
Slide 11: Engineering Design Process Steps
· Ask students if they think all engineers solve their problems in one try. Explain to students that it takes many tries to get something correct in engineering. In engineering, there is no such thing as a mistake, only opportunities to learn. It is okay to fail. Just find the mistake and correct it. In engineering, there is never one correct solution. There are always many solutions to a problem and always improvements that can be made. The steps that engineers take to find these solutions are called the engineering design process. 
· Ask students to read the first big step (Identify) 
· What does identify mean? (To point out or find). Engineers design solutions, what do they need to know first before they can find the answer? (The problem) 
· How do people know when they have found the correct answer? In engineering, there are no correct answers, just better ones. Explain to students that there are expectations that engineers must meet called criteria. For example, when engineering a football, what does a football need to do? (Bounce, look a certain way, have laces, have air inside, etc.). Those things are all called criteria, by comparing the design to the criteria, an engineer knows a solution will work. Is a child-sized football the same as an adult football? The criteria for both footballs include: leather, the white laces for fingers, and the shape. However, the two footballs would have different criteria on the size. The footballs are similar, but different because of different criteria. 
· Once the criteria are understood for the design challenge, what could make it difficult for an engineer to design their solution? (Money, time, materials, etc.) Explain to students that these rules are called constraints, or rules that engineers must follow. Engineers are given constraints they must follow when finding the solution to a problem. Think about football again, what are college and professional footballs made from? (Leather). What if instead the rule (or constraint) was to not use leather, could another type of football be made instead? Many of the footballs for sale are made of rubber because the engineer had different constraints. 
· Ask students to read the next step (Imagine) 
· Ask students what imagine, or imagination, means. Are these things real, or tangible? They may not be real, but they help give us ideas about what things could be. In this step, see what materials are available, then brainstorm, or think, about possible ideas/solutions to the problems. 
· Explain to students that there are no right answers in engineering. Start with as many ideas as possible. 
· Ask students to read the next step (Plan) 
· The third big step of the engineering design process is to plan out the idea. Make sure that what is designed can be repeated. A plan will help an engineer identify where mistakes happen so they can be fixed.
· When planning, begin with the brainstorming phase. Each team member will contribute their ideas, And then the team combines the different ideas!
· Once ideas are combined into a single group idea, determine what materials will be used for the solution and make sure the design has met the criteria and constraints of the project. 
· Ask students to read the next step (Create) 
· The fourth step is to create! Since this is the very first creation, it is called a prototype. A prototype is a first or preliminary model of something from which other forms are developed or copied. A prototype is created to test the engineer’s idea or concept. Engineers asks themselves, “Did the idea work the way we wanted it to?” After testing the idea, the engineer will make improvements to the prototype. 
· Ask students to read the last step (Improve) 
· Finally, the last step is to improve. How does an engineer know if the prototype did well on the test? It must meet certain expectations and follow some rules. But how do engineers determine how well it met the expectations and how well it followed the rules? In school, how do you know if you mastered something? (Grades). The prototypes made today will be scored using a scorecard or rubric. By looking at the score, each team will determine if the design could be better. If improvements should be made, then the team will revisit the plan and decide what to do to improve the score. Remember, there are no correct answers in engineering, just better solutions. 

	IDENTIFY
	Slide 12-13: Identify - Problem 
· Have students read the bolded section. 
· Ask students to identify the problem.
· Explain to students that they will put on their engineering hats today to fix our ecosystem by designing a process to eliminate the invasive species.
· Show students how the UV beads glow and demonstrate how that fluorescence can be measured.  Explain that the number on the outside of each tray is the current amount of fluorescence with the UV beads present.
Slide 14: Identify - Criteria (Desired Outcomes)
· Ask students what criteria or desired outcomes mean.
· Explain to students those criteria are what engineers use to determine if they have successfully solved the engineering problem.
· Ask students how we will know if we are successful engineers today.
· Design a one minute process that:
· Leads to a decrease in invasive species
· Teacher’s Note: The amount of invasive species will be measure quantitatively with fluorescent analysis in ImageJ.  The starting fluorescence (% Area) should be noted on the outside of the box before students begin.
· Protects the native species (non-UV beads)
· Limits environmental damage
· Explain to students that their design process can only last one minute.
Slide 15-16: Identify - Constraints (Limitations) 
· Ask students what constraints or limitations mean.
· Explain to students those constraints are rules the engineers must follow.
· Explain the constraints for this engineering design activity are:
· Time Limit: Students will have 25 minutes to make and test the tools you’d like to use for your process.
· Materials: Students can only use the available materials.
· Budget: Students will have $1,000 to complete this challenge.
· Teacher Note:  If play money is available, we recommend using it.  Monetary values may feel too abstract for students, so providing something more tangible will help.  
· Collaboration: One design element from each team member must be used in the final design. Explain to students that a design element is taking one part of someone’s idea and adding it to another.
· Redesign: Each team can test their prototypes and process as many times as needed during the 25-minute design phase.
· Teacher Note: When a team is ready to test their design, they should raise their hand. The teacher will then ask them to come to the testing station and test their design. If a team received a low score on any part of the design, the team should redesign if they still have time.

	IMAGINE
	Slide 17: Identify - Explore Materials
· Students will be designing a process to eliminate as many of the invasive species as possible. During the first trial, students experienced how an invasive species can cause damage to the balance of an ecosystem when there is no natural predator to control its population. As a result, they will be designing ways to specifically eliminate the invasive species from the environment. The design will include a step-by-step process using tools they have “purchased” from the supply table. For example, Step 1- Rake the environment. Step 2-Use a spoon to scoop up the species pulled from the rake. Modifications can be done to the tools to better implement their process if desired. 
· Depending on classroom size, each team’s process will be tested at a testing location. If space is not available, the teacher or facilitator may go to each team station to test their process.
Slide 18: Imagine - Brainstorm
· Give students one (1) minute to individually design and draw a plan of what the ecosystem and/or tool will look like. Emphasize that students should not talk during this minute or share ideas. Remind students their ideas will be used as design elements for the final design.
· After a minute, give students five (5) minutes to present and share their ideas with the group. Let students know that they should focus on key aspects of their idea to be used as design elements for the final design when sharing.
· Teacher’s Note: If students are struggling with an idea for their design, provide ideas without giving the solution. For example, “This is a design that I tried earlier, but it failed. What could I do to improve it?” Emphasize that the design failed to reinforce that it is okay to fail and to let students know they cannot copy the design and expect success.

	PLAN
	Slide 19: Plan - Plan Development
· Hand out the scorecard that will be used during the design challenge. Review the testing criteria with the class and answer questions. The testing criteria will inform their design decisions.
· Have students collaborate to come up with a final design. Let students know they must include at least one element from each team member for their final design.
· Ask students again what the design criteria are:
· Design a process that:
· Leads to a decrease in invasive species
· Teacher’s Note: This will be measured in ImageJ at the testing station.
· Leaves native species unharmed (non-UV beads)
· Teacher’s note: To see if any of the removed beads are native species, shine a UV flashlight over the removed “species”.  If any of them do not glow, that would indicate that a native species has been removed instead of the invasive species.
· Limits environmental damage
· Students will need to select the materials to be used for their design process and develop a budget for the project. Students will have $1,000 to “purchase” materials for their design at the classroom supply table. The prices used in this challenge can be found in the materials list. Students will raise their hand when they are ready to purchase materials. The teacher will make sure the appropriate amount of money is used to purchase each material but will not guide students on following their budget. Students can go over the budget but remind them that they will lose points on their score card.
Slide 20: Plan – Team Member Responsibilities *
· Each team member must be given responsibility, such as materials manager, banker, head engineer, and quality control manager.

	CREATE
	Slide 21: Create - Design Your Ecosystem
· Let students know to have fun, be creative with their designs, and work together.
· Remind students that being an engineer is not about getting the solution on the first try. There is no right answer, just better solutions.
Slide 22: Identify – Criteria
· Reminder slide for students to look at while working
Slide 23-24: Create – Test 
· Teacher will time students as they implement their process for 1 minute.
· Teacher will take a photo of the resulting tray under UV light to calculate the overall fluorescence of the final tray and will use that to help complete the rubric.
· Students will calculate their scores when testing in front of the teacher or facilitator.

	IMPROVE
	Slide 25: Improve - Redesign: Discussion
· Students will reflect on their scores and discuss:
· What worked?
· Teacher’s Note: Focus on the materials being used and ask why they think those materials were helpful. Ask students what characteristics of the environment allowed certain species to be supported. What aspects of their design process allowed the invasive species to become easier to remove?
· What did not work? 
· Teacher’s Note: Focus on the materials being used and ask why they think those materials did not work as well. Ask students what characteristics of the environment made it difficult to remove the invasive species.
· What do you want to improve?
· Teacher’s Note: Focus on engineering aspects with students. Ask students why they were designing a process for the ecosystem. Ask students if they found a solution or just part of one. Reinforce that it is okay to not succeed on the first try and that engineering is about making improvements over time. Ask students how they would design their process differently if they had no rules? Ask students if working together was difficult. Learning to work together is very important and it is easier to find a solution with many ideas rather than just one idea.




Curriculum adapted with permission from Learning Undefeated, all rights reserved.
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